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A P P E N D I X A

Icons and Menus Displayed in CTM

This appendix describes the icons used in CTM. This appendix contains the following sections:

• A.1 Network Map Icons, page A-1

• A.2 CTM Menu Bars, page A-8

• A.3 Domain Explorer Legend, page A-27

A.1 Network Map Icons
The Network Map allows you to visualize the structure of your network. Table A-1 displays the icons 
that appear in the Network Map. When you open the Network Map from a selected NE in the Domain 
Explorer or Subnetwork Explorer, the selected NE is preselected on the map. The icon has white text 
displayed on a black background. This allows you to distinguish the previously selected NE from the 
other NEs in the same map.

You can customize the Network Map with numeric NE icons. Each NE model has a numeric icon. 
Numeric icons behave the same as the standard graphical icons in terms of color, operational state, and 
so on. The right-most column in Table A-1 describes the numeric icons.

Table A-1 Network Map Icons

Device Map Icon Numeric Icon

Cisco CRS-1 —

Cisco XR 12000 —

Cisco Catalyst 6509 —

Cisco MGX Voice Gateway —
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nsport Manager Release 6.0 User Guide



  

Appendix A      Icons and Menus Displayed in CTM
A.1   Network Map Icons
Cisco MDS 9000 —

ONS 15216 EDFA

ONS 15216 DWDM

ONS 15216 OADM

ONS 15216 DCU

ONS 15216 OSC

ONS 15302

ONS 15305

ONS 15310

ONS 15327

ONS 15454 SDH

ONS 15454 SONET

Table A-1 Network Map Icons (continued)

Device Map Icon Numeric Icon
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A.1   Network Map Icons
ONS 15454 ROADM

ONS 15454 DWDM Hub

ONS 15454 DWDM Line

ONS 15454 DWDM OADM

ONS 15454 DWDM Terminal East

ONS 15454 DWDM Terminal West

ONS 15454–Unknown

ONS 15501  

ONS 15530

ONS 15540

ONS 15600

ONS 15800

Table A-1 Network Map Icons (continued)

Device Map Icon Numeric Icon
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A.1   Network Map Icons
ONS 15801

ONS 15808 optical add/drop multiplexing site

ONS 15808 optical line amplification site

ONS 15808 back-to-back terminal site

ONS 15808 east terminal site

ONS 15808 west terminal site

ONS 1580x regeneration site

—

ONS 1580x regeneration site

—

ONS 1580x optical add/drop multiplexing site

—

ONS 1580x back-to-back terminal site

—

ONS 1580x optical line amplification site

—

ONS 1580x east terminal site 

—

Table A-1 Network Map Icons (continued)

Device Map Icon Numeric Icon
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A.1   Network Map Icons
ONS 1580x west terminal site 

—

ONS 1580x OADM regenerator site

—

Network partition

—

Area

—

Building

—

City

—

Central office point of presence (POP)

—

Group

—

Subnetwork

—

Home

—

Not Managed/Other Vendor

Note The Not Managed/Other Vendor icon is 
customizable.

—

Table A-1 Network Map Icons (continued)

Device Map Icon Numeric Icon
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A.1.1 Icon States
Table A-2 describes the icon states for the icons displayed on the Network Map. Icon states are displayed 
according to condition priority. If two or more of the following states occur simultaneously on an icon, 
only the state with the highest priority is displayed:

• Loss of communications

• Under maintenance

• Unacknowledged alarms

Table A-2 Icon States

State Icon Color Overlay Example

Loss of communications Icon color indicates whether the NE is 
reachable

Red and white border

Under maintenance Icon color indicates whether the NE is 
under maintenance

Yellow and black border

Unacknowledged 
alarms

Icon color indicates whether an 
unacknowledged alarm is present on the 
NE

Cream border

Initializing Icon color indicates that the NE is 
initializing

Blue and white border

Synch configuration Icon color indicates that the NE is in the 
synchronization configuration state

Blue and black border

Out of Service Gray None

Preprovisioned Teal NE ID is preceded by a question 
mark (?); for example, ?DALLAS01

GNE None NE ID is preceded by an asterisk 
(*); for example, *AUSTIN01
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A.1.2 Icon Colors
Table A-3 shows the colors that correspond to alarm status.

Note Link colors and NE alarm colors are identical.

LNE None NE ID is preceded by a caret (^); for 
example, ^DALLAS02

Unknown NE model Gray None

Off-view icon Icon color indicates the last know alarm 
status of the NE that the off-view icon 
represents.

None

Table A-2 Icon States (continued)

State Icon Color Overlay Example

Table A-3 Icon Colors

Alarm Status Color Example

Critical Red

Major Orange

Minor Yellow

Warning Light blue

Clear Green
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A.2   CTM Menu Bars
A.2 CTM Menu Bars
The CTM menus are described below. The associated toolbar icons are listed next to their corresponding 
menu options.

A.2.1 File Menu
Table A-4 describes the tools and options in the File menu.

Out of Service Gray

Preprovisioned Teal

Table A-3 Icon Colors (continued)

Alarm Status Color Example

Table A-4 File Menu Tools Descriptions

Item Tool Description

Add Network Element(s) Opens the Add New Network Element wizard, which allows you to add a new 
NE or add several new NEs at once.

Add New Network Partition Opens the Add New Network Partition dialog box, which allows you to add new 
network partitions to the domain.

Add New Subnetwork Opens the New Subnetwork dialog box. From here, you can add a new 
subnetwork, give the subnetwork a name, specify the type and topology, and 
provide a brief description of the subnetwork.

Close — Closes the current window.

Dashboard — Opens the Cisco Transport Manager Dashboard, which shows the number of 
NEs in the management domain, and the number of critical, major, minor, 
warning, or unacknowledged alarms. In addition, the dashboard contains an 
Alarm Browser tool, which allows you to launch the Alarm Browser window, 
and an Open Domain Explorer tool, which layers the Domain Explorer window 
as the top active window.

Debug Options — Opens the Debug Options dialog box. Use this dialog box to select parameters 
for the Debug Log, which contains data that is useful for debugging purposes.

Domain Explorer — Layers the Domain Explorer window as the top active window.

Domain NE Table — Opens the Domain NE table for the selected node.

ENE Devices — Opens the ENE Devices table for the selected node.

Exit — Exits the program.
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Appendix A      Icons and Menus Displayed in CTM
A.2.1   File Menu
Export Data to File Opens the Export dialog box.

Filter Opens a filter dialog box, which allows you to filter for information found in the 
table or window.

Note Use the percent sign (%) as a wildcard character for filtering on 
substrings.

Filter Time Period Allows you to filter using time as a parameter. As the default, CTM displays 
alarm and event information that occurred during the last four hours.

To quickly filter the time period, select the Filter Time Period (4h) tool. You can 
change the default time period by using the User Preferences dialog box. The 
icon displayed in the tool bar changes according to the time period selected.

Generate HTML Report Allows you to generate an HTML report based on the data in the table. You can 
generate a report for selected rows or for all rows. After you have made your 
selection, the browser window appears with the HTML report. Use your 
browser's Print option to print the HTML report.

Launch Bulk NE Wizard — Opens the Bulk NE Wizard, which allows you to add multiple NEs 
simultaneously.

Lock CTM Client — Prevents the CTM client from being used and opens the CTM Locked window.

Network Map Opens the Network Map window for the selected node.

New Group Opens the New Group dialog box. From here, you can add a new group, give the 
group a name, specify the group’s geographic location, and provide a brief 
description of the group.

Notify Users — Opens the Notify Users dialog box.

Page Back Moves the table backward by one page if there is more than one page of data.

Page Forward Moves the table forward by one page if there is more than one page of data.

Parent (also Show Parent 
Network Map) 

If the Network Map is open to a specific NE, clicking Parent or Show Parent 
Network Map shifts the view back to the main Network Map view.

Print Graph Prints the graphical display.

Refresh Circuit Power 
Levels

— (ONS 155xx only) Refreshes the values in the Destination Optical Power 
column.

Table A-4 File Menu Tools Descriptions (continued)

Item Tool Description
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A.2.1   File Menu
Refresh Data Refreshes all data being displayed by CTM. There are two icons, and both 
refresh data from either the server or the database. The Refresh Data icon with 
blue and red arrow (as seen in the Circuit table) flashes when updates are 
available. This icon has two modes: manual refresh and autorefresh.

The Refresh Data icon with the gray disc and red arrow (as seen in the VLAN 
table) does not notify you that updates are available. You must click the button 
in order to retrieve updated data.

Note Clicking Refresh Data in the Domain Explorer window refreshes all data 
for the entire CTM client. Depending on the number of NEs in your 
network, you might experience a delay while the data refreshes.

Note If you click Refresh Data in the NE Explorer window, a dialog box 
appears with the following prompt: How would you like to 
synchronize this NE’s configuration? Choose one of the following 
options:

— From Server: The data in the NE Explorer is refreshed with the values 
in the database.
— From Network Element: The database is refreshed with the current 
configuration on the NE, and the NE Explorer is updated accordingly.

Note It takes longer to refresh data from the NE than from the server.

Reset Network Element — Resets the selected ONS 1580x NE.

Revert to Default — Reverts your map customizations (map background, node icons, and x and y 
coordinates) as the default map view.

Save Saves changes made in the current window.

Save as Default — Saves your map customizations (map background, node icons, and x and y 
coordinates) as the default map view.

Set PM Collection Status Opens the PM Collection Status dialog box. Use this dialog box to enable or 
disable PM collection for specific modules and display the results in the PM 
Module table.

Show Discrepancy Details Shows detailed information about the selected ONS 155xx discrepancy.

Show Parent Network Map See Parent.

Subnetwork Explorer — Opens the Subnetwork Explorer window.

Table A-4 File Menu Tools Descriptions (continued)

Item Tool Description
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A.2.2 Edit Menu
Table A-5 describes the tools and options in the Edit menu.

Table A-5 Edit Menu Tools Descriptions

Item Tool Description

Accept (ONS 15600 only) Copies the downloaded software onto the standby TSC and 
activates it.

Activate — Activates the selected image and reboots the device.

Activate CTC Binary Allows you to activate the selected CTC binary. There can be only one active 
CTC binary at a time. If you select a CTC binary that is already active, the 
Activate CTC Binary tool becomes unavailable.

Add Allows you to add an entry to the table. Selecting Add opens the Add SNMP 
Parameters dialog box, in which you can enter a target IP address, the write and 
read community strings, the number of connection retry attempts, and the timeout 
(the length of time after which a connection attempt is aborted).

Add CTC Binary Allows you to specify a CTC JAR file to upload to the CTM server. Clicking the 
Add CTC Binary tool (or choosing Edit > Add) opens the Upload CTC Binary 
File dialog box, where you can enter the CTC JAR filename or click Browse to 
browse for the filename. In addition, you can make the new binary the active 
binary by checking the Activate check box.

Add EFD Profile Opens the Create Event Forwarding Discriminator Profile wizard.

Add GateWay/TL1 User Opens the Add GateWay/TL1 User window.

Add NE User Opens the Add NE User wizard.

Add Predefined User Opens the Add Predefined User wizard.

Add Supported NE Allows you to add an NE to the Supported NE table and specify its software 
version.

Cancel Job Allows you to cancel a scheduled job. Cancel is enabled only for jobs with a 
Queued status.

Cancel Task Allows you to cancel a task.

Change Map Background — Opens the Select Map Background dialog box, which allows you to choose a 
different geographic background for the selected view.
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A.2.2   Edit Menu
Change Node Icon — Opens the Select Node Icon File dialog box, which allows you to select a new 
icon for the selected node.

Change Password — Opens the Change Password dialog box, which allows you to change your CTM 
or CTC user password.

Circular Layout — Arranges the NE on the Network Map in a circular formation.

Collapse Collapses the management domain or group to hide all groups or NEs in that 
management domain or group.

Collapse All Links — Collapses all links on the Network Map.

Commit For the ONS 15327 and ONS 15454, the Commit operation makes the standby 
software version the active version if it is a later version than the active software.

For the ONS 1580x, the running software version is the same as the active 
software version.

Note Commit is not applicable to ONS 15302, ONS 155xx, and ONS 15600 
NEs.

Copy Copies the selected NE.

Create a New User Opens the Create New CTM User wizard. When launched from the 
GateWay/CORBA Client Configuration table, opens the Add GateWay/CORBA 
User dialog box.

Create a New User Profile Opens the Create New User Profile wizard.

Create CTC User Profile Opens the Create CTC User Profile wizard.

Create Ring Opens the Create DWDM Ring wizard, which allows you to add new DWDM 
rings to the DWDM Ring table.

Cut Copies the selected NE. The NE is not removed from its current location until the 
Paste action is performed.

Declutter Layout — Rearranges the icons on the Network Map so that they do not overlap.

Table A-5 Edit Menu Tools Descriptions (continued)

Item Tool Description
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Delete — Deletes the selected instance of the NE or group. 

If this is the last instance of the NE, the NE is placed in the Deleted NEs group. 
Only out-of-service or preprovisioned NEs can be placed in the Deleted NEs 
group.

To delete the NE from the database, select the NE in the Deleted NEs group and 
choose Edit > Delete; then, click OK. This removes the NE from the client view 
and deletes all records associated with the NE from the database.

If this is the last instance of the group, the group must be empty before you can 
delete it.

Note You cannot delete a GNE that has associated subtending NE(s). You can 
disassociate a subtending NE from the GNE by deleting and purging it or 
by assigning it to a different GNE.

Note You cannot delete an NE that has links to it that are defined in the Link 
Table. Before deleting the NE, you must first delete the links to it.

Delete Deletes the selected item.

Delete All — Deletes all instances of the selected NE or group.

The NE is placed in the Deleted Network Elements group. Only out-of-service or 
preprovisioned NEs can be placed in the Deleted NEs group. The group must be 
empty before you can delete it.

Note You cannot delete a GNE that has associated subtending NE(s). You can 
disassociate a subtending NE from the GNE by deleting and purging it or 
by assigning it to a different GNE.

Note Delete All does not delete items in a range. Rather, Delete All deletes 
multiple instances of the same NE or group.

Delete BLSR/MS-SPRing Deletes the selected BLSR or MS-SPRing.

Delete CTC User Profile Deletes the selected CTC user profile.

Delete EFD Profile Deletes the selected event forwarding discriminator profile.

Delete Link Deletes the selected link.

Delete Ring Deletes the selected DWDM ring.

Table A-5 Edit Menu Tools Descriptions (continued)

Item Tool Description
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Delete User Profile Deletes the selected user profile.

Duplicate User Profile Opens the Create Duplicate Profile window, which allows you to duplicate an 
existing CTM user profile.

Edit BLSR/MS-SPRing Opens the Edit BLSR/MS-SPRing window, which allows you to modify the ring 
ID, ring reversion, and span reversion on a ring.

Enable Drag Enables drag-and-drop functionality for all nodes in the Network Map window.

Enable Offview Enables the display of off-view icons in the Network Map window.

Exercise BLSR/MS-SPRing Opens the Exercise BLSR/MS-SPRing window, which allows you to set up 
BLSR/MS-SPRing scheduling data immediately or for an exact time.

Expand Expands the management domain or group to display all groups or NEs in that 
management domain or group.

Expand All Links — Expands all links on the Network Map.

Find — Opens the Find dialog box, which allows you to search the tree by node name, IP 
address, or description.

Find Next — Searches for the next occurrence of the entry that was searched for using the Find 
command.

Modify CTC User Profile Opens the Modify CTC User Profile wizard.

Modify EFD Profile Opens the Modify Event Forwarding Discriminator Profile wizard.

Modify GateWay/TL1 User Opens the Modify GateWay/TL1 User window.

Modify Link Opens the Modify Link wizard, which allows you to modify the name or 
description of the selected link.

Modify NE User Opens the Modify NE User wizard.

Table A-5 Edit Menu Tools Descriptions (continued)

Item Tool Description
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Modify Ring Opens the Modify DWDM Ring wizard, which allows you to modify the name of 
the selected DWDM ring.

Modify User Profile 
Properties 

Opens the Modify CTM User Profile Properties wizard.

Modify User Properties Opens the Modify CTM User Properties wizard. When launched from the 
GateWay/CORBA Client Configuration table, opens the Modify 
GateWay/CORBA User dialog box.

NE Active Users Opens the NE Active Users table.

NE Software Table Opens the NE Software table.

Paste Pastes the NE into the selected group.

Revert/Switch For the ONS 15327 and ONS 15454, the Revert/Switch operation reverts the 
active software version back to the standby version.

For the ONS 1580x, the Revert/Switch operation makes the standby software 
version the running version.

Note Revert/Switch is not applicable to ONS 15302, ONS 155xx, and ONS 
15600 NEs.

Spring Layout — Arranges the icons on the Network Map in a coiled spring formation. 

Squeeze — If you select a file that is marked “deleted” and use this command, the file will 
be physically removed from flash memory. 

Table Layout — Arranges the icons on the Network Map in rows and columns.

Tag Under Maintenance — Allows you to give a port the status of Under Maintenance. Select an in-service 
port and choose Edit > Tag Under Maintenance.

Upgrade BLSR/MS-SPRing Allows you to upgrade the selected BLSR or MS-SPRing.

Undelete — Undeletes the selected object.

Undelete — Restores all instances of an NE in the Deleted Network Elements group to their 
previous locations in the Domain Explorer tree.

If the original parent group no longer exists, CTM does not recreate the group. 
Instead, CTM restores the NE under the management domain node.

Unlock User Allows you to unlock a user account.

Table A-5 Edit Menu Tools Descriptions (continued)

Item Tool Description
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A.2.3 Fault Menu
Table A-6 describes the tools and options in the Fault menu.

User Note Allows you to add a note to the job.

User Preferences — Opens the User Preferences dialog box.

Verify — Verifies the checksum of the selected flash file.

Zoom Area Allows you to pan and zoom the view to a different region.

Zoom In Allows you to zoom in on the Network Map.

Zoom Out Allows you to zoom out on the Network Map.

Table A-5 Edit Menu Tools Descriptions (continued)

Item Tool Description

Table A-6 Fault Menu Tools Descriptions

Item Tool Description

Acknowledge Alarms Acknowledge the selected alarm(s). Click again to unacknowledge the 
selected alarm(s). To enable alarm unacknowledgement, choose Control 
Panel > UI Properties. 

Acknowledge All Alarms Acknowledges all alarms. Click again to unacknowledge all alarms.

Alarm Browser Opens the Alarm Browser window.

Alarm Log Opens the Alarm Log window.

Clear Security Violation Alarm — Clears any security violation alarms on the selected NE. This option is only 
available from the NE Explorer window. If this option is not available on the 
selected NE, the Clears Security Violation Alarms option is grayed out. A 
message appears if there are no security violation or intrusion alarms on the 
NE or if the operation has been accepted.

Clear Selected Alarm(s) Clear selected alarms. A message appears, informing you that only PM failed 
and PM lost alarms on NEs in your domain will be cleared.

Event Export Manager — Opens the Event Export Manager window.
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A.2.4 Performance Menu
Table A-7 describes the options in the Performance menu.

Hide Acknowledged Alarms Hides all alarms that have been acknowledged.

Hide Cleared Alarms Hides all alarms that have been cleared.

Locate Alarm/Event Opens the NE Explorer for the NE where the selected alarm or event is 
located.

MGX Voice Gateway — Opens the Diagnostic Center, which allows you to diagnose NEs, monitor 
statistic events for network manageability, and diagnose connections for 
MGX devices.

Ping NE — Pings the selected NE for IP connectivity.

Reset All Alarms/Events Clears (resets) all alarms or events from the current view.

Show Alarm Note Opens the Alarm Note dialog box for the selected alarm.

Show Cleared Alarms Shows all alarms that have been cleared.

Stop Continuous Beep — Disables continuous audible notification whenever a new update occurs in the 
Dashboard window.

Test NE Connectivity — For ONS 155xx NEs, tests SNMP connectivity to the selected NE using the 
community string configured in the CTM client.

Table A-6 Fault Menu Tools Descriptions (continued)

Item Tool Description

Table A-7 Performance Menu Descriptions

Item Description

PM Query by NE Model Allows you to search for PM data based on the NE model.

PM Query by Category Allows you to search for PM data based on the PM category.

MGX Voice Gateway Opens the Statistics Report, which allows you to view reports of statistics data that are 
collected from the MGX device. 
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A.2.5 Configuration Menu
Table A-8 describes the tools and options in the Configuration menu.

Table A-8 Configuration Menu Tools Descriptions

Icon/Item Tool Description

Add Drops Opens the Add L2 Service Drops window.

Add Member Opens the Add Member wizard, which allows you to add new members to an 
existing VCAT circuit.

Cancel Roll Cancels the pending circuit roll.

Cisco 6509 — Opens the Equipment Inventory table for the selected Cisco 6509.

Cisco CRS-1 — Opens the Equipment Inventory table and allows you to rediscover some or all 
CRS-1 NEs.

Cisco XR 12000 — Opens the Equipment Inventory table and allows you to rediscover some or all 
XR 12000 NEs.

Duplicate QoS Profile Opens the Duplicate QoS Profile dialog box.

Complete Roll Use the Complete Roll button to terminate a manual roll. You can do this when a 
manual roll is in a ROLL_PENDING state and you have not yet completed the roll 
or have not canceled its sibling roll. 

Create Circuit Allows you to create a circuit between NEs in the same group or subnetwork or 
between NEs in different groups or subnetworks. When you select an NE and 
choose Configuration > Circuit Wizard, the pointer changes to a plus symbol 
(+), indicating that you are in Create Circuit mode. Click the destination NE to 
open the Create Circuit wizard, prepopulated with the source and destination 
nodes.

Create Circuit Roll Opens the Roll Circuit wizard.

Create L2 Service Opens the Create L2 Service wizard.

Create L2 Topology Opens the Create L2 Topology wizard.
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Create Link Allows you to create a link between NEs in the same group or subnetwork or 
between NEs in different groups or subnetworks. When you select an NE and 
choose Configuration > Create Link, the pointer changes to a plus symbol (+), 
indicating that you are in Create Link mode. Click the destination NE to open the 
Create Link wizard, prepopulated with the source and destination nodes. After the 
link is created, it is viewable in the Network Map window.

Create QoS Profile Opens the Create QoS Profile dialog box.

CTC-based SDH NEs — Opens the MS-SPRing table, Create MS-SPRing wizard, Equipment Inventory 
table, L2 Topology table, Create L2 Topology wizard, QoS Profile table, Create 
QoS Profile wizard, Alarm Profiles Management dialog box, NE Defaults 
Management dialog box, Circuit table, DWDM Ring table; launches CTC; and 
allows you to update or repair a circuit.

CTC-based SONET NEs — Opens the BLSR table, Create BLSR wizard, Equipment Inventory table, L2 
Topology table, Create L2 Topology wizard, QoS Profile table, Create QoS Profile 
wizard, Alarm Profiles Management dialog box, NE Defaults Management dialog 
box, Circuit table, Rolls table, Configure Node dialog box, DWDM Ring table; 
launches CTC or the TL1 interface; and allows you to update or repair a circuit.

Delete Circuit Allows you to delete an existing circuit. You can also select and delete multiple 
circuits.

Delete Drops Deletes the selected drop. A popup window appears. Click Yes to delete the L2 
service or click No to close the window without deleting the L2 service.

Delete L2 Service Deletes the selected L2 service. A popup window appears. Click Yes to delete the 
L2 service or click no to close the window without deleting the L2 service.

Delete L2 Topology Deletes the selected L2 topology. A popup window appears. Click Yes to delete the 
L2 topology or click No to close the window without deleting the L2 topology.

Note You must delete any L2 services on the selected topology before you can 
delete the selected topology.

Delete Link Deletes the selected link.

Delete QoS Profile Deletes the selected QoS profile. 

Equipment Inventory Table — Opens the Equipment Inventory table for the selected NE.

Finish Roll Use the Finish Roll button to complete the circuit processing of both manual and 
automatic rolls. It changes the circuit state from ROLL_PENDING to ACTIVE. 

J1 Path Trace — Opens the J1 Path Trace window.

Table A-8 Configuration Menu Tools Descriptions (continued)

Icon/Item Tool Description
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L2 Service Table Opens the L2 Service table.

Launch Device Manager — Launches the Device Manager for MDS 9000 NEs.

Link Table — Opens the Link table.

Manage VLANs — Opens the Manage VLANs dialog box, which allows you to create new VLANs or 
delete existing VLANs from the CTM domain.

MDS 9000 — Launches the Fabric Manager and the CLI. The Fabric Manager provides:

• Fabric discovery and topology mapping

• Multiple switch configuration

• VSAN and zone management

• Fabric checker, switch health, and zone merge analysis

• End-to-end connectivity and traceroute analysis 

Member Circuits Opens the VCAT Member table.

Merge Merges different circuits into one or more new circuits.

MGX Voice Gateway — Opens the Equipment Inventory table, Chassis View, and Configuration Center for 
MGX devices.

Modify Circuit Opens the Modify Circuit window.

Modify Drops Opens the Modify L2 Drops window.

Modify L2 Service Opens the Modify L2 Service wizard.

Modify L2 Topology Opens the Modify L2 Topology wizard.

Modify Link Opens the Modify Link wizard, which allows you to modify the name or 
description of the selected link.

Modify a QoS Profile Opens the Modify QoS Profile wizard.

Table A-8 Configuration Menu Tools Descriptions (continued)

Icon/Item Tool Description
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NE Explorer Opens the NE Explorer window.

NE Remote Console Launches the local Telnet application.

ONS 15216 — Opens the Equipment Inventory table and launches the TL1 interface and the CLI.

ONS 15302 — Opens the Equipment Inventory table and launches the CLI and Cisco Edge Craft.

ONS 15305 — Opens the Equipment Inventory table and launches the CLI and Cisco Edge Craft.

ONS 155XX — Opens the Equipment Inventory table, Circuit table, NE Discrepancy table, 
Discovery Info table; allows you to rediscover some or all NEs; and launches 
CiscoView, the TL1 interface, the CLI, and the Cisco IOS CLI.

ONS 1580X — Opens the Equipment Inventory table or the Domain 1580x table and launches the 
TL1 interface for the selected ONS 1580x NE.

Open Circuit Path Span 
Table

Opens the Circuit Path Span table.

Open Circuit Path Table Opens the Circuit Path table for the selected link. Unavailable for some NEs.

Open Circuit Span Opens the Circuit Span table.

Open Circuit Table Opens the Circuit table for the selected link. Unavailable for some NEs.

Open Link Utilization Table Opens the Link Utilization table for the selected link.

Refresh Lined Up Circuits Refreshes any new aligned circuits with the selected circuit.

Roll Circuit Opens the Roll Circuit wizard, which allows you to transfer ONS 15600 traffic 
from one facility to another without service interruption.

Show Contained Circuits — (ONS 15530 only) Opens a second Circuit table, which shows the circuits 
contained within the selected circuit.

Show Circuit Note Allows you to view and add notes to circuits displayed in the Circuit table.

Table A-8 Configuration Menu Tools Descriptions (continued)

Icon/Item Tool Description
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A.2.6 Administration Menu
Table A-9 describes the tools and options in the Administration menu.

Show Drops Opens the L2 Service Drop Ports table.

Show QoS Profile Opens the QoS Classes table.

Start Template 
Configuration CLI 
Recording

Starts recording configuration operations.

Stop Template 
Configuration CLI 
Recording

Stops recording configuration operations and opens the Save Template 
Configuration dialog box, which saves configuration details to a template file.

Trace Circuit Opens the Circuit Trace Report window, which traces the connectivity of a circuit 
by showing the source node, the destination node, and any intermediate nodes in 
graphical format.

VLAN Table — Opens the VLAN table.

Table A-8 Configuration Menu Tools Descriptions (continued)

Icon/Item Tool Description

Table A-9 Administration Menu Tools Descriptions

Item Tool Description

Add Predefined User Opens the Add Predefined User wizard.

Add User Opens the Add User wizard.

Audit Log Opens the Audit Log window.

Cisco IOS-XR Based 
Devices

— Opens the User Settings table for IOS XR-based devices.

Compare Config Files — For the CRS-1, compares backed-up memory configuration files that were saved 
with the Memory Backup feature. The comparison highlights any differences 
between configuration file versions.

Control Panel — Opens the Control Panel window.

CTC-based NEs — Opens the NE User Access Administration table, Audit Trail table, Security 
Advisory Message Management dialog box, NE Authentication dialog box, or 
Cisco IOS Users table.
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CTC Upgrade Table — Opens the CTC Upgrade table.

CTM User Profiles Opens the CTM User Profiles table.

CTM Users — Opens the CTM Users window.

Delete Log Opens the Delete Log wizard, which allows you to delete logs for ONS 1580x 
NEs.

Delete User Opens a user deletion confirmation window. Click Yes to delete the selected user.

Disconnect User Disconnects the selected user from the CTM application.

Enable/Disable Log Opens the Enable/Disable Log Activation wizard.

Error Log Opens the Error Log window.

GateWay/TL1 Users — Opens the CTM GateWay/TL1 Client Configuration table.

GW/CORBA Client 
Configuration Table

— Opens the CTM GateWay/CORBA Client Configuration table.

GW/TL1 EFD Table Opens the CTM GateWay/TL1 Event Forwarding Discriminator table.

Image Download — Opens the Image Upload window.

Job Monitor — Opens the Job Monitor table.

Logged in CTM Users Opens the Logged In CTM Users table, which lists the CTM users who are 
currently logged into the CTM application.

Logged in GateWay CORBA 
Users

Opens the Active GateWay/CORBA Users table, which lists the CTM 
GateWay/CORBA users who are currently logged into the CTM application.

Logged in GateWay TL1 
Users

Opens the Logged In GateWay/TL1 Users table, which lists the CTM 
GateWay/TL1 users who are currently logged into the CTM application.

Log Out GateWay CORBA 
User

Logs out the selected CTM GateWay/CORBA user from the CTM application.

Table A-9 Administration Menu Tools Descriptions (continued)

Item Tool Description
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Log Out GateWay TL1 User Logs out the selected CTM GateWay/TL1 user from the CTM application.

Log Out User Logs out the selected user from the CTM application.

Memory Backup — Opens the Memory Backup dialog box.

Memory Backup Upload — Opens the Backup File dialog box.

Memory Restore — Opens the Memory Restore dialog box.

MGX Voice Gateway — Opens the Audit Trail Viewer, which records MGX device activities across the 
Configuration Center, Chassis View, Statistics Reporting Tool, and Diagnostic 
Center in a persistent file.

Modify User Opens the Modify User wizard.

NE Active Users Opens the NE Active Users table.

NE Software Table — Opens the NE Software table.

NE Users Access Activity 
Log

Opens the NE Users Access Activity Log table.

ONS 15216 — Opens the NE User Access Administration table and the NE Authentication 
dialog box.

ONS 155XX — Opens the SNMP Settings table, Flash File table, or NE Authentication dialog 
box.

ONS 1580X — Opens the NE User Access Administration table, NE User Access Log table, or 
NE Authentication dialog box.

Retrieve Last Activity Time Refreshes the Last Activity Time field for the current list of active users, if the 
activity time has changed. The last activity time is the date and time when the last 
activity was performed by the active user on the NE.

Self Monitor — Opens the Self Monitor table, where you can view information about CTM 
threshold parameters.

Service Monitor — Opens the Service Monitor table.

Show Failed Login Attempts Opens the Unknown User Login Attempts table.

Show User Note Allows you to view a user note.

SNTP Configuration — Opens the SNTP Configuration dialog box.

Table A-9 Administration Menu Tools Descriptions (continued)

Item Tool Description
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A.2.7 View Menu
Table A-10 describes the tools and options in the View menu.

Software Management — The Optical submenu opens the Software Download wizard for optical NEs.

The IOS-XR submenu opens the IOS XR Software Package Management wizard, 
which allows you to manage software packages for CRS-1 and XR 12000 NEs. 

Supported NE Table — Opens the Supported NE table.

Template Configuration — Opens the Template Configuration dialog box, which allows you to apply 
template files to multiple CRS-1 and XR 12000 NEs at a scheduled time.

Unlock Allows you to unlock a user account.

Update Log Updates the NE Access Log table.

Table A-9 Administration Menu Tools Descriptions (continued)

Item Tool Description

Table A-10 View Menu Tools Descriptions

Item Tool Description

Clear Screen Clears the current real-time PM data buffer of all values.

Configure Graphing 
Parameters

Plots gauge parameters that have been stored over time. You can select parameters to 
plot on the same X-axis and modify the preselected start and end time. For 15-minute 
PM data, the time period can be plus or minus 125 hours from the selected row time 
stamp.

Fit in Window Sizes the graph within the window. When multiple graphs are displayed, select a 
graph with your mouse pointer; then, click Fit in Window.

Launch Real-Time 
Performance Session

Launches a real-time PM session from the selected row in the PM table.

If you select more than one row (or no rows), the toolbar icon is disabled.

Normalize Y Axes Allows you to normalize axes values in PM graphs and compare data of the same type 
(for example, receive versus transmit packets).

Plot Retrieves the available data points (rows) from the CTM database and plots the graph. 
When the row selection changes on the table, you must click Plot again.

Restore Y Axes Allows you to restore axes values to the previous graph visualization in comparable 
PM graphs.
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A.2.8 Window Menu
Table A-11 describes the tools and options in the Window menu.

Specify Real-Time 
Polling Interval

By default, the real-time PM session polls the attributes every 10 seconds. Click this 
toolbar icon to change the real-time polling interval, or to start or stop real-time 
polling. The polling interval range is from 10 to 900 seconds.

Toggle Graph Toggles between line and bar graphs.

Zoom In Reduces the scope of the graph. When multiple graphs are displayed, select a graph 
with your mouse pointer; then, click Zoom In.

Zoom Out Increases the scope of the graph. When multiple graphs are displayed, select a graph 
with your mouse pointer; then, click Zoom Out.

Table A-10 View Menu Tools Descriptions (continued)

Item Tool Description

Table A-11 Window Menu Tools Descriptions

Item Tool Description

Arrange Horizontally — When multiple CTM windows are open, this option displays the windows 
side-by-side horizontally.

Arrange Vertically — When multiple CTM windows are open, this option displays the windows 
side-by-side vertically.

Cascade — When multiple CTM windows are open, this option positions the active window in 
the upper left corner, and all other windows are layered on top of the active window 
in cascading order.

Close All — Closes all CTM windows except the Domain Explorer.

Minimize All — Minimizes all CTM windows.

Restore All — Restores all minimized CTM windows.

Reset to Default Size Resets the current window to its default size.
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A.2.9 Help Menu
Table A-12 describes the tools and options in the Help menu.

A.3 Domain Explorer Legend
The following tables describe the icons shown in the Domain Explorer tree.

A.3.1 Domain Explorer Object Icons
Table A-13 describes the object icons in the Domain Explorer tree.

Table A-12 Help Menu Tools Descriptions

Item Tool Description

Contents and Index — Displays the contents and index for the online help.

Current Window Displays online help for the current window.

About Cisco Transport 
Manager

— Opens the About Cisco Transport Manager dialog box, which lists the CTM 
release you are running, including server and client version.

Table A-13 Domain Explorer—Object Icons

Object Icon

Management domain

GNE

LAN-connected NE (LNE)

End NE (ENE)

Group

Subnetwork (shown in the Subnetwork Explorer)

Network partition (shown in the Subnetwork Explorer)

Cisco CRS-1
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Cisco Catalyst 6509

Cisco XR 12000

Cisco MGX Voice Gateway

Cisco MDS 9000

ONS 15216 DCU

ONS 15216 DWDM

ONS 15216 EDFA

ONS 15216 OADM

ONS 15216 OSC

ONS 15302

ONS 15305

ONS 15310

ONS 15327

ONS 15501

ONS 15530

ONS 15540

ONS 15454

ONS 15600

ONS 15800

Table A-13 Domain Explorer—Object Icons (continued)

Object Icon
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A.3.2 Domain Explorer Communication State Icons
Table A-14 describes the communication state icons in the Domain Explorer tree.

A.3.3 Domain Explorer Operational State Icons
Table A-15 describes the operational state icons in the Domain Explorer tree.

ONS 15801

ONS 15808

Unknown NE

Unmanaged NE

Table A-13 Domain Explorer—Object Icons (continued)

Object Icon

Table A-14 Domain Explorer—Communication State Icons

State Icon

Available

Unavailable

Not Applicable

Table A-15 Domain Explorer—Operational State Icons

State Icon

Preprovisioned

In Service

In Service–Initializing

In Service–Synch Configuration
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A.3.4 Domain Explorer Severity Icons
Table A-16 describes the severity icons in the Domain Explorer tree.

Under Maintenance

Out of Service

In Service–Undiscovered

Table A-15 Domain Explorer—Operational State Icons (continued)

State Icon

Table A-16 Domain Explorer—Severity Icons

Severity Color Icon

Critical Red

Major Orange

Minor Yellow

Warning Light Blue

Cleared Green

Unknown Gray
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A.3.5 Domain Explorer Operational and Communication State Map 
Representation Icons

Table A-17 describes the operational and communication state map representation icons in the Domain 
Explorer tree.

Table A-17 Domain Explorer—Operational and Communication State Map Representation

State Icon Icon Color Border Color

Loss of Communication (Communication State is 
Unavailable)

Red Red/white

Preprovisioned

Note In the Preprovisioned state, a question mark (?) 
appears before the node name to indicate that the 
node might be a GNE when it becomes In Service.

Teal Red/white

In Service Corresponds to 
the highest 
severity alarm 
on the node

Yellow

In Service–Initializing

Note In the In Service state, an asterisk (*) appears before 
the node name if that node is a GNE.

Gray Blue/white

In Service–Synch Configuration Red Blue/black
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A.4 Icons Used for MGX Products
This section describes the icons and menus used for MGX products.

A.4.1 Launching Applications
Applications specific to MGX products can be launched from the toolbar and dashboard, as well as from 
menu options. Table A-18 list the icons.

Under Maintenance Red Black/yellow

Out of Service Gray None

Table A-17 Domain Explorer—Operational and Communication State Map Representation (continued)

State Icon Icon Color Border Color

Table A-18 Cisco MGX Product Icons

Application Icon

Chassis View

Configuration Center
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A.4.2 Hierarchy Pane Icons
The following tables describe the icons shown in the Hierarchy pane:

• A.4.2.1 Object Icons

• A.4.2.2 Hierarchy Pane Navigation Icons

A.4.2.1 Object Icons

Table A-19 describes the object icons in the Hierarchy pane.

Diagnostic Center

Statistics Report

Table A-18 Cisco MGX Product Icons (continued)

Application Icon

Table A-19 Object Icons

Object Icon

Card

Folder

Group

Line

Network

Path

Peripheral
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A.4.2.2 Hierarchy Pane Navigation Icons

Table A-20 lists the icons that are used to navigate through the hierarchy pane in the Configuration 
Center, Statistics Report, and Diagnostic Center. 

Port

Route Node

Routing Node

RPM Subinterface

Sensor

Unknown NE

Virtual Port

Table A-19 Object Icons (continued)

Object Icon

Table A-20 Hierarchy Pane Navigation Icons

Item Icon

Find

Find Next

Find Previous

Expand One Level

Expand Two Levels
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A.4.3 Inspector View Icons
In the Configuration Center and Statistics Report, the Inspector View provides a list of detailed 
information for the selected NE from the hierarchy view. Click the Show static data button to update 
the information in the Inspector View. 

Expand Three Levels

Sort Ascending/Descending

Table A-20 Hierarchy Pane Navigation Icons (continued)

Item Icon

Table A-21 Inspector View Icons

Icon Example

Show static date

Refresh static data
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